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FREQUENTLY ASKED QUESTIONS 
 

The FAQs are in 5 Parts- 
Part A: General 
Part B: Application and Uploading of Documents 
Part C: Questions pertaining to Specific Document Types 
Part D: After Application Submission 
Part E: Troubleshooting and Other Technical Problems 

 

 
 

 
ELECTRONIC SUBMISSION OF SUPPORTING DOCUMENTS VIA EPOL 

PART A: GENERAL 

A1 What is the objective of requiring employers to upload supporting documents at 
the time of work pass application? 

 Previously, work pass applicants submitted physical copies of most supporting 
documents when they visited the Employment Pass Services Centre (EPSC) or Work 
Pass Services Centre (WPSC) to have their fingerprints enrolled. 

 
There have been occasions when the in-principle approvals for some foreigners had 
to be withdrawn after detecting inconsistencies between their supporting documents 
and the declared application details. This resulted in uncertainty and inconvenience for 
both these foreigners as well as their employers. 

 
By verifying the foreigner’s supporting documents upstream at the stage of work pass 
application, we would be able to provide greater certainty to employers and work pass 
applicants on the application outcome. 

A2 When was this new EPOL feature introduced? 

 It was launched on 1 April 2011. 

A3 Does  the  new  feature  apply  to  EntrePass,  Personalised  Employment  Pass, 
Miscellaneous Work Pass and Work Holiday Pass? 

 It is not available for EntrePass, Personalised Employment Pass, Miscellaneous Work 
Pass and Work Holiday Pass at this juncture. 

A4 I do not have a scanner. Can I scan my supporting documents at the MOM 
premises like the MOM e-lobby? 

 No, MOM does not provide scanning services for this purpose. 
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PART B: APPLICATION AND UPLOADING OF DOCUMENTS 

B1 Will I be informed to upload the supporting documents? 

 Yes, you will be prompted on which documents to upload at the ‘Document Upload 
Section’ found on the Application/Renewal Confirmation page. 

B2 What type of supporting documents will I be asked to upload? 

 The type of document you will be asked to upload depends on the type of passes you 
apply for. For more details on other additional documents that may be requested, 
please refer to the table in Annex A. 

B3 What does MOM consider to be an official English translation? 

 An official English translation refers to translations done by a certified translator, High 
Commission/Embassy, or a notary public. 

B4 How do I upload the supporting documents in the EP Online application? 

 You can upload the documents by scanning them to create softcopies in your computer 

system, and then attaching them to the field when prompted by the EP Online 
system. Please ensure that the scanned documents comply with the file specifications 
indicated in the upload page on the EP Online system. 

B5 What type of scanner should my company purchase? 

 Regular scanners available at most electronic retail outlets should be sufficient for 
your use. However, if your company submits a high volume of work pass applications, 
you may wish to consider purchasing a feeder/batch scanner which allows for bulk 
scanning of documents. 

 
Please check that the scanner comes with a built-in PDF conversion software that 
allows your documents to be automatically scanned into a PDF (portable document 
format) file. 

B6 What  are  the  recommended  computer  settings  for  electronic  upload  of 
documents? 

 The system is supported on Microsoft Internet Explorer 6.0 and above, running on : 

• Windows XP Professional Service Pack 2; or 

• Windows Vista 
 
Please check your Internet Explorer version (refer to question E2) and set your 
Internet Browser to the recommended settings (refer to question E3, E4 and E5) 
before you proceed with work pass application online. 

B7 What are the image/file guidelines for the scanned documents that I wish to 

upload? 

 - All scanned images must be clear for viewing (all text must be sharp, and 
photographs should show facial features clearly) 

- Non-English documents should be accompanied by an official English translation 
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 and saved in the same file 
- File format should be in Portable Document Format (PDF) or JPEG only 
- Document file size should not exceed 2MB 

 
We recommend that your scanners be set to scan at a resolution of at least 150 dpi 
(dots per inch), in either 'colour' (preferred) or 'greyscale' mode. 

B8 Where can I obtain a PDF conversion software or PDF reader software if my 
computer does not have one? 

 PDF is widely used for electronic documents and forms exchange; it is supported by 

many software*. You may wish to refer to the following websites for more information 
on obtaining the software: 

 
PDF Conversion: 
www.cutepdf.com 
www.primopdf.com 
www.binarynow.com/products/print2pdf/ 

 
PDF Reader: 
www.adobe.com 

 
* Please note any licensing conditions that may apply for the software by reading the software 
terms and conditions. 

B9 How do I convert my picture files (e.g. in JPEG, TIFF, GIF, BMP formats etc) into 
PDF files? 

 Please refer to Annex B for a step-by-step guide on how to do the conversion. 

B10 My document comprises of 3 pages in separate PDF files (3 PDF files). How can 
I combine them into 1 file? 

 
At the Document Upload Window, press the  button to upload the first file, 

then press the button to upload more files. The system will combine the 
files for you into 1 file. 

 
The method described above can also be used to combine multiple JPEG files. 

B11 How long does it take to upload one file? 

 Time required to upload document varies according to the file size. A larger file size 
will require a longer uploading time. You may upload a few files concurrently to reduce 
waiting time. Generally, to upload three documents of 1MB file size each at the same 
time, it will take approximately 2.5 minutes. However, in times of peak EPOL usage, 
this may take up to 8 minutes. 

B12 The file that I am trying to upload exceeds 2 MB. What should I do? 

 You can reduce the size of your file by adjusting your scan settings. For instance, you 

may wish to scan the image using ‘greyscale’ setting instead of ‘colour’ setting. 
 
Please ensure that the documents are still clear for viewing after the adjustments have 

http://www.cutepdf.com/
http://www.primopdf.com/
http://www.binarynow.com/products/print2pdf/
http://www.adobe.com/
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 been made. 

B13 Can I submit an application without uploading all the supporting documents 
requested for? 

 No, all document uploads have to be completed before an application can be 
submitted. If you have not prepared the soft copy documents for upload, you may click 
on the “Save” button in EPOL to save a draft of your application, and return to it later 
to continue. 

 
In addition, please note that uploading of irrelevant documents in place of the correct 
documents may result in the application being voided or rejected. 

B14 I have saved my application as I am not able to complete it in my current 
session.  How  long  will  my  uploaded  documents  be  retained  in  the  draft 
application? 

 Documents uploaded and saved in draft applications will only be kept for a period of 

14 days from the last date you had saved this draft application. 

B15 When I accessed the Application/Renewal Confirmation Page previously, the 
Document Upload Section displayed a list of documents to be uploaded. 
However, when I returned to this page later, I notice that I am now no longer 
required to upload any documents. Why is this so? 

 If you had amended one or more details in your application, it is possible that based 
on the latest application details, you are no longer required to upload any supporting 
documents. 

B16 On the Document Upload Page, I notice that some of my documents that I had 
previously uploaded have been removed. Why is this so? 

 You have recently amended one or more details in your application. Therefore, the 
previous copy of document you had uploaded may no longer be relevant or accurate, 
and has been removed. 

PART C: QUESTIONS PERTAINING TO SPECIFIC DOCUMENT TYPES 

C1 TRAVEL DOCUMENT & RELATIONSHIP PAPERS 
(e.g. Marriage Certificate, Birth Certificate, etc) 

C1- 1 How should I key in the name of the applicant in the application form? 

 (a) Key in the name exactly as it appears on the travel document, and in the same 
order of appearance 
(b) Exclude salutations such as ‘Dr’, ‘Miss’, etc. 
(c) The following are not allowed - colon ( : ) , comma ( , ) and full stop ( . ) 
(d) For accented characters (e.g. Ã, Ö, Ø, Ê ), please refer to the “Machine Readable 
Zone” at the bottom of the travel document biodata page for its transliteration (e.g. Ö 
is transliterated as OE) 
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C1-2 The applicant has an existing FIN and I have keyed in his/her FIN. The system 

then displays the FIN holder’s personal particulars (e.g. Name, Date of Birth, 
Nationality, etc) on the screen. However, I notice that there is an error in the 
details displayed. What should I do? 

 

You should not proceed with the application. Please fill up the ‘Request Form for 
Amendment of Personal Particulars (EP Online)’, attach the relevant supporting 
documents and submit the amendment request. 

 
When the amendment has been completed, you may then proceed to make the 
application. 

 

C2 EDUCATION-RELATED DOCUMENTS 
(e.g. educational certificate, transcripts, etc) 

 

C2-1 I am being prompted to upload an educational certificate, however, the applicant has 
only recently graduated and has not  yet received the certificate. What should 
I do? 

 

Instead of the educational certificate, you may upload transcripts/letter from the 
institution confirming that the applicant has successfully fulfilled the course 
requirements and has attained the qualification for which the certificate is to be 
awarded at a stipulated date. 

 

C2-2 I am being prompted to upload an educational certificate; however, the applicant 
has lost his certificate. Can I submit other supporting documents instead? 

 

You may submit transcripts/letter from the educational institution clearly stating that 
the applicant has completed the course/program and has been awarded the 
qualification. In addition, please submit a letter of explanation to explain why the 
certificate is not available. We will then assess if this is acceptable. 

 
If the applicant is not able to produce any of the above items, that educational 
qualification should not be declared in the application 

 

C2-3 The applicant holds a degree from an Indian education institution, and I am 
being prompted to upload his transcripts/marksheets in addition to the 
educational certificate. How many transcripts/ marksheets should I upload? 

 

You should upload their complete set of transcripts/marksheets. 
 
 

C3 PAPERS RELATED TO SUPPORT FROM VETTING AGENCY/ PROFESSIONAL 
BODY/ ACCREDITATION AGENCY 
(e.g. SFA Licence, Singapore Nursing Board Practising Certificate, etc) 

 

C3-1   I operate several F&B outlets in Singapore and I am prompted to upload a copy of 
the Singapore Food Agency (SFA) licence. Is it acceptable to upload a 
licence which has an address different from applicant’s place of duties? 

 

The licence to be uploaded must be valid and it must show the address which is 
consistent with the applicant’s place of duties stated in the work pass 
application/renewal. 
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Application/Pass Status Documents still retrievable for viewing? 
Pending 
(application is still under process and 
outcome is not yet known) 

Yes 

Approved Yes, till the work pass card has been 
collected 

Rejected Yes, for 6 months from the rejection date 
Invalid 
(application has been voided) 

Yes, for 14 days from date of voiding 

Withdrawn No 
Cancelled No 

 

 

PART D: AFTER APPLICATION SUBMISSION 

D1 How will I be notified on the status of the application I have submitted? 

 If you had selected to receive SMS or email notifications at the ‘Electronic Notification’ 
section of the Application or Renewal, you will be notified at the stated mobile number 
or email address, for the following: 

 
(a) The application outcome (including applications which have been voided) 
(b) Request(s) for any additional documents during the processing of the application 

D2 Will I be able to retrieve the uploaded document files from EPOL for my viewing 

after I have submitted the application? 

 The documents will remain retrievable depending on the application/pass status as 
summarised in the table below: 

D3 What happens if I have uploaded a wrong or unclear supporting document? 

 If there are errors in data entry or in document uploads, the application may be 
rendered void, and will not be processed. You will need to re-submit a new application 
and pay the relevant application fees (if any). Hence, you are strongly advised to 
check your application details and document uploads for accuracy, completeness and 
clarity before you submit the application. 

D4 I  realise  that  I  have  uploaded  the  wrong  document  immediately  after  the 
application was submitted. What should I do? 

 Please login to EPOL to withdraw the application and re-submit a new application with 
the correct details and documents. 

D5 When I checked the status of my application/ renewal, the system showed that it 
was ‘Invalid’. What does this mean? 

 The application was voided due to one or more of the following reasons: 
 
(a) Data entry error in the application/renewal 
(b) Documents uploaded are wrong or incomplete (i.e missing items) 
(c) Documents uploaded were unclear 

 
There will be an advisory message stating the fields where the data entry errors were 
detected, or the documents that were unclear, wrong or incomplete. 
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If you still wish to apply for the work pass, you will need to submit a new application 
and upload all supporting documents again. Please note that the relevant application 
fees (if any) will apply. 

PART E : TROUBLESHOOTING & OTHER TECHNICAL PROBLEMS 

E1 I am shown an error message when I click on the “Upload/View Document(s)” 
button on the Confirmation page. I am informed that I need to wait for 20mins 
before I can proceed with uploading documents. What should I do? 

 Your recent document upload session had been interrupted or terminated abruptly. 
Please click on the ‘Save’ button at the bottom of the EPOL page to save a draft of 
your application. You may retrieve this draft application after 20 minutes to continue 
with the uploading. 

E2 How do I check my Internet Explorer version? 

 Please refer to Annex C for a step-by-step guide on how to check my Internet Explorer 
version. 

 
If your Internet Browser’s version is 6.0, please refer to C4, 
If your Internet Browser’s version is 7.0 or 8.0, please refer to C9 
If your Internet Browser’s version is 9.0, please refer to C12 

E3 How do I clear the cache files in my Internet Browser? 

  
Please refer to Annex C for a step-by-step guide on how to check my Internet Explorer 
version. 

 
If your Internet Browser’s version is 6.0, please refer to C2, 
If your Internet Browser’s version is 7.0, please refer to C5, 
If your Internet Browser’s version is 8.0, please refer to C6, 
If your Internet Browser’s version is 9.0, please refer to C10 
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E4 What are the recommended cache settings for my Internet Browser? 

 The cache settings on for Internet Explorer should be as follows: 
 

 
 
Please refer to Annex C for a step-by-step guide on how to do clear the internet cache 
and set the above settings. 

E5 How do I enable Pop-up window in my Internet Browser? 

  
Please refer to Annex C for a step-by-step guide on how to check my Internet Explorer 
version. 

 
If your Internet Browser’s version is 6.0, please refer to C3, 
If your Internet Browser’s version is 7.0 or 8.0, please refer to C7, 
If your Internet Browser’s version is 9.0, please refer to C11 
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Relationship Documentary Proof 
Spouse Marriage Certificate 
Child Birth Certificate 
Adopted Child Official Adoption Papers 

 

 

 

Documents Required for Work Pass Applications 

ANNEX A 

 

For non-English documents, you must upload the original document and an English translation. The translation can be done by a translation service provider. 
 

Besides the supporting documents listed here, we may ask for other documents when we review your application. If you are asked for the verification proof of your candidate’s 
qualifications, you can get it from a background screening company. Alternatively, if the educational institute has an online instant verification portal, you can submit the screenshot 
and web page address showing the verification result. 

 

Pass Type Applied For Supporting Documents you may be required to Upload Additional Notes 

 
Employment Pass (EP) 
/ S Pass 

 
(a) Travel Document Page showing the personal particulars and travel 

document number. Please include pages reflecting amendments to details 
(e.g. name, expiry date), if any. The photograph should show the facial 
features clearly. 

 
(b) [For institutions not found in the application form’s drop-down list] 

Educational Certificates and verification proof 
 
(c) Registration or Support Letters from the relevant Vetting Agency/ 

Professional Body/ Accreditation Agency, if support from them has been 
declared in the application. 

 
For item (b) 
For diploma and above qualifications from India or China, besides the 
educational certificates and verification proof, you may need to upload these 
documents: 

 
• India: Transcripts and marksheets. 

• China: Verification proof. You can get the verification proof directly in 
English from any one of these verification channels: 

 
1. Center for Student Services and Development (Formerly known as 

China Higher Education Student Information) 
2. Background screening companies  

 
For item (c) 
The regulatory and registration agencies/bodies referred to are: 

 
• Singapore Food Agency : • Allied Health Professions Council 

Foodshop/foodstall licence • Sport Singapore 
• Singapore Medical Council • Enterprise Singapore 
• Singapore Dental Council • Traditional Chinese Medicine 
• Singapore Nursing Board Practitioners Board 
• Singapore Pharmacy Council • Unit for Prehospital Emergency 
• Legal Services Regulatory Care 

Authority 

 
Dependant’s Pass (DP) 

 

 

 

 

 

 

 

 

 

 
(a) Travel Document Page showing the personal particulars and travel 

document number. Please include pages reflecting amendments to details 
(e.g. name, expiry date), if any. The photograph should show the facial 
features clearly. 

 
(c) Documentary proof of the relationship between the Main Pass Holder and 

the following DP applicant: 

 

https://www.mom.gov.sg/faq/work-pass-general/what-are-the-requirements-for-a-verification-proof#examples-of-background-screening-companies
http://www.chsi.com.cn/en
https://www.mom.gov.sg/faq/work-pass-general/what-are-the-requirements-for-a-verification-proof#examples-of-background-screening-companies


Updated on 27/09/2022 

 

 

Relationship Documentary Proof 
Common Law 
Spouse 

• A copy of the common-law marriage 
certificate; or 

• A letter from the embassy acknowledging that 
the main pass holder and spouse are in a 
common-law relationship under the laws of 
their country; or 

• An affidavit from the main pass holder 
declaring that he/she and spouse are in a 
common-law relationship under the laws of 
their country. The affidavit must also be 
notarised in that same country. 

Unmarried 
stepchildren under 
21 years of age 

• A copy of the court order on the child’s 
custody 

• A letter from the other biological parent 
stating there is no objection to bringing the 
child to Singapore. 

Unmarried 
handicapped 
children above 21 
years of age 

A letter or report from a medical practitioner on the 
child’s condition. 

Parent A copy of the main pass holder’s birth certificate 
which states the names of the parents 

 

 

Pass Type Applied For Supporting Documents you may be required to Upload Additional Notes 

 
Long Term Visit Pass 
(LTVP) 

 
(a) Travel Document Page showing the personal particulars and travel 

document number. Please include pages reflecting amendments to details 
(e.g. name, expiry date), if any. The photograph should show the facial 
features clearly. 

 
(b)  Documentary proof of the relationship between the Main Pass Holder and 

the following LTVP applicant: 
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Pass Type Applied For Supporting Documents you may be required to Upload Additional Notes 

 
Training Employment 
Pass (TEP) 

 
(a) Travel Document Page showing the personal particulars and travel 

document number. Please include pages reflecting amendments to details 
(e.g. name, expiry date), if any. The photograph should show the facial 
features clearly. 

 
(b) Educational Certificates 

 
(c) Detailed Training Programme stating the employing company name, 

training objective and duration of training. 
 
(d) Support Letters from Education Institution stating that the training is part of 

the Degree/Diploma program (for applicants on training attachments as 
part of their undergraduate degree program). 

 
(e) Registration or Support Letters from the relevant Vetting Agency/ 

Professional Body/ Accreditation Agency, if support from them has been 
declared in the application. 

 
For item (b) 
For diploma and above qualifications from India or China, besides the 
educational certificates, you may need to upload these documents: 

 
• India: Transcripts and marksheets. 

• China: Verification proof. You can get the verification proof directly in 
English from any one of these verification channels: 

 
1. Center for Student Services and Development (Formerly known as 

China Higher Education Student Information) 
2. Background screening companies  

 
- If the applicant has not yet completed the educational course, please 
upload a letter from the educational institution confirming that this applicant 
is currently pursuing the said course in their school. 

 
For item (e) 
The regulatory and registration agencies/bodies referred to are: 

 
• Singapore Food Agency: • Allied Health Professions Council 

Foodshop/foodstall licence • Sport Singapore 
• Singapore Medical Council • Enterprise Singapore 
• Singapore Dental Council • Traditional Chinese Medicine 
• Singapore Nursing Board Practitioners Board 
• Singapore Pharmacy Council • Unit for Prehospital Emergency 
• Legal Services Regulatory Care 
Authority 

 
Letter of Consent 
(LOC) 

 
(a) Registration or Support Letters from the relevant Vetting Agency/ 

Professional Body/ Accreditation Agency, if support from them has been 
declared in the application. 

(b) Declaration Form for a Letter of Consent. This must be signed by the 
applicant and the employer, as well as the employment agent (if 
applicable). 
Note: You can get this form only at the Confirmation page before you 
submit the application on EPOL. 

 

 

 

 

 

 

 

 

 

 
For item (a) 
The regulatory and registration agencies/bodies referred to are: 

 
• Singapore Food Agency: • Allied Health Professions Council 

Foodshop/foodstall licence • Sport Singapore 
• Singapore Medical Council • Enterprise Singapore 
• Singapore Dental Council • Traditional Chinese Medicine 
• Singapore Nursing Board Practitioners Board 
• Singapore Pharmacy Council • Unit for Prehospital Emergency 
• Legal Services Regulatory Care 

Authority 
 

 

http://www.chsi.com.cn/en
https://www.mom.gov.sg/faq/work-pass-general/what-are-the-requirements-for-a-verification-proof#examples-of-background-screening-companies


 

 

 
 

 
 

ANNEX B 
 

Converting multiple pictures into PDF files 
 

Step 1: Put all your picture files that you wish to convert to PDF into one folder. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 2: Select one or more images to be converted to PDF, and right-click your 

mouse on those pictures. Choose Print when the menu pops up 



 

 

 
 

Step 3: When the Print Wizard appears, and you will be prompted to choose a 

printer. Please choose your installed PDF writer (e.g. CutePDF Writer) from 

the printer list. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

 

Step 4: By default, Full Page Fax Print (i.e. one picture for each PDF page) in the 

output PDF file will be selected. You might arrange two pictures per PDF 

page, or four pictures per page, or even more pictures per page by selecting 

your desired layout from the layout list on the left column of the Print Wizard. 
 

 

 



 

 

Step 5: After “Next” button is clicked, you will be prompted to provide a filename as 

well as select the location where the file is to be saved in. 
 

 

 
 

 

Step 6: Upon clicking on the “Save” button, the document will be converted into PDF 

format and stored in the selected location. 
 

 

 



 

 

 

 
 
 
 

 

Another way of converting your picture file into a PDF file 

Step1: Start your graphics processing software (e.g. Microsoft Paint) 

Step 2: Open your picture file 

Step 3: From the Main Menu, select "File"->"Print" 

Step 4: For Printer, please select your installed PDF writer (e.g. CutePDF Writer) 

Step 5: Click "OK" 

Step 6: A dialog box will pop up.  Provide a filename as well as select the location 

where the file is to be saved in. Click “Save”. 

Step 7: Your file will then be converted into a PDF file and stored in the selected 

location 



 

 

ANNEX C 
 

C1. How do I access the Internet Settings on Internet Explorer 6.0 
 

1. To go to the Internet Settings dialog box, click on the “Tools” top menu and 
select the “Internet Options” as shown below. 

 

 
 

2. The Internet Options dialog box will be displayed shown below. 
 

 



 

 

C2. How do I delete the cache files in Internet Explorer 6.0 
 

1. Click on the “Delete Cookies” button and click the “OK” button to delete the 
cookies as shown below. 

 

 
 
 
 

2. You might have to wait for a few minutes for the cookies to be deleted. 
 

3. Click on the “Delete Files” button, check on the “Delete all offline content” and 
click the “OK” button to delete all offline files as shown below. 

 

 



 

 

4. Click on the “Clear History” button, check on the “Delete all offline content” 

and click the “Yes” button to delete all history files as shown below. 
 

 
 

 
5. You should have by now clear your cache files. Click on the “Settings” button and set 

the option for the “Check for newer versions of stored pages” to “Automatically”. The 
“Settings” dialog box will be displayed as shown below. 

 

 
 

6. Click the “OK” button to close the “Settings” dialog box and click the “Apply” button 
and the “OK” button to close the “Internet Options” dialog box shown. 



 

 

C3. How do I enable the Pop-up for my Internet Explorer in IE6.0? 
 

1. To go to the Internet Settings dialog box, click on the “Tools” top menu and 
select the “Internet Options” as shown below. 

 

 
 

2. The Internet Options dialog box will be displayed shown below. 
 

 



 

 

3. Click on the “Privacy” tab as shown below. 
 

 
 

4. Uncheck the “Block pop-ups” if it is initially checked as shown below. 
 

 
 

5. Click the “Apply” button and the “OK” button to close the “Internet Options” dialog 
box. 



 

 

C4. How do I check the version of my Internet Explorer browser in IE6.0? 
 

1. To check the version of your Internet Explorer browser, click on the “Help” top 
menu and select the “About Internet Explorer” as shown below. 

 

 
 

2. The Internet Explorer dialog box will be displayed as shown below. 
 

 
 

3.  In the dialog box shown above, the Version of the Internet Explorer version is 6.0 



 

 

 
 

C5. How do I delete the cache files in Internet Explorer 7.0 
 

1. Click on the “Tools” dropdown menu and click the “Internet Options” menu as 
shown below. 

 

 
 

 
 

2. The Internet Options dialog box will be displayed as shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on the “Delete” button on the “General” tab. 
4. A “Delete Browsing History” dialog box will be shown below. 



 

 

 

 
 

5. Click on the “Delete files” button and click the “Yes” button to delete the files. 
6. Click on the “Delete cookies” button and click the “Yes” button to delete the 

files. 
7. Click on the “Close” button to close the “Delete Browsing History” dialog box 
8. You should have by now clear your cache files. Click on the “Settings” button and 

the “Settings” dialog box will be displayed as shown below. 
 

 
 

9. Click the option for the “Check for newer versions of stored pages” to “Automatically”. 

 
10. Click the “OK” button to close the “Settings” dialog box and click the “Apply” button 

and the “OK” button to close the “Internet Options” dialog box shown. 



 

 

 
 

 
 

C6. How do I delete the cache files in Internet Explorer 8.0 
 

1. Click on the “Tools” dropdown menu and click the “Internet Options” menu as 
shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. The Internet Options dialog box will be displayed as shown below. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click on the “Delete” button on the “General” tab. 
4. A “Delete Browsing History” dialog box will be shown. 



 

 

C7. How do I enable the Pop-up for my Internet Explorer in IE7.0 and IE8.0? 
 

1. To go to the Internet Settings dialog box, click on the “Tools” dropdown menu 
and select the “Pop-up Blocker” as shown below. 

 

 
 

 
 

2. The Pop-up Blocker will be turned off. 
 

C8. How do I check the version of my Internet Explorer browser in IE7.0 and 
IE8.0? 

 

1. To check the version of your Internet Explorer browser, click on the “Help” top 
menu and select the “About Internet Explorer” as shown below. 

 

 
 

2. The Internet Explorer dialog box will be displayed as shown below. 
 
C9. How do I check the version of my Internet Explorer browser in IE8.0? 

 

1. To check the version of your Internet Explorer browser, click on the “?” icon 

on the dropdown menu.  
 

 

2. Select the “About Internet Explorer” as shown below. The About Internet 
Explorer dialog box will be displayed as shown below. 



 

 

 
 

C10. How do I clear the cache if my Internet Explorer’s version is 9.0? 

1. Click on the icon  at the top menu at the right hand corner. 
 
 
 

2. Click to select on the “Internet Options”  from the drop down menu. 
 

 
 

3. An “Internet Options” dialog box will be displayed as shown below. 



 

 

 

 
 

4. A “Delete Browsing History” dialog box will be displayed as shown below. 

 
 

 

5. Ensure that the “Temporary Internet files’, “Cookies”, “History” checkboxes 

are ticked. Then, click on the “Delete” button to delete the cache. You might 

have to wait for a few minutes while the cache files are being deleted. 



 

 

6. Click on the “Settings” button and ensure that the option button for 

“Automatically” is checked under the “Check for newer versions of stored 

pages” as shown below. 

 

 
 
7. Click the “OK” button to close the “Temporary Internet Files and History 

Settings” dialog box. 

8. Click the “OK” button to close the “Internet Options” dialog box. 



 

 

C11. How do I enable the pop-up blockers in Internet Explorer version 9.0? 
 

1. Click on the icon  at the top menu at the right hand corner. 

2. Click to select on the “Internet Options” from the drop down menu. 
 

 
 

3. Click on the “Privacy” tab as shown below. 

 
 

4. Uncheck the “Turn on Pop-up Blocker” to turn off Pop-up Blocker. 

5. Click on the “Apply” button. 

6. Click on the “OK” button to close the “Internet Options” dialog box. 



 

 

C12. How do I check the versions of my Internet Explorer’s version  in my 
computer for Internet Explorer 9.0? 

1. Click on the icon  at the top menu at the right hand corner. 

2. Select the “About Internet Explorer” from the dropdown menu. 

3. The About Internet Explorer dialog box will be displayed as shown below. 
 

 

 


